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Two basic concepts before getting started

There are many ways to survey a building, and all have been well developed in Europe in recent
centuries. But all the solutions share a common difficulty:

1) how to correctly measure the angle formed by joining two walls;

2) how to join the rooms to complete the design.

To tackle these issues, HouseMap has chosen a very simple approach based on two well-known
concepts.

The first concept
Of course all architecture students know how to correctly measure the angles: by applying
trigonometry and using topographic instruments.

However elegant, it’s a solution that’s often too costly for regular, day-to-day work. So that’s why
with HouseMap we have used a more simple approach using basic geometry: with our method,
you divide up the closed polygon of each room into the number of triangles needed to cover the
whole floor surface.

To get you familiar with this concept, take a look at these three examples: you can see that if we
only measure the length of the sides, the structure of the space rotates around the corners.
Mathematically, the number of solutions is infinite, so you need to start out by knowing the value
of angle alpha.

          

When we are sure the angles are all 90°, there are no problems with rotation, but what if they
aren’t? We can’t measure the angles using a goniometer, because an error of just 1° would
cause a miscalculation of 6 cm on a 4 meter-long wall.

By returning to our basic geomatry, we know that, if we have the lengths of the three sides of a
triangle, we can calculate its internal angles.

We go about this by dividing the areas into various triangles, and to do this, the solution
emerges almost on its own: we use the diagonals to create triangles and, therefore, to uniquely
define the angles.

      

4 walls= 1 diagonal       6 walls= 3 diagonals        7 walls= 4 diagonals
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The minimum number of diagonals needed to calculate the room is “the number of the walls,
minus 3”.

By altering the length of the diagonals, the room geometry changes and, with it, the size of the
angles of the closed polygon.

By applying this solution to the first example illustrated, you can see straight away that you no
longer need to specifically measure the angles.

          

HouseMap is exciting: when you alter the length of a diagonal, the whole geometric form of the
room automatically follows your changes, as the ends of the diagonals are tightly connected to
the corners of the space.

And now the second concept
Of course there are differences between surveying the cathedral in St. Mark’s Square and a more modest modern apartment.
Although originating from Venice, Pocket-HouseMap has been studied to solve the latter type of job.

This allows us fantastic freedom: we can assume that the dividing walls between two rooms are of the same thickness, at which
point we need only decide where to join the rooms.

Here too, Pocket-HouseMap offers a simple solution: for the connection, which elements do two
adjacent rooms have in common? Their doors!

      

As we will see below, Pocket-HouseMap joins all the rooms which have doors with the same
name in common, and, with a single command, will make up the whole apartment.

So we can avoid having to define topographical relationships between the rooms and simply
refer to the thickness of the walls and the position of the doors.
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Part 1: A first glance

Chapter 1 The working environment and tools

The Main Window
To start Pocket-HouseMap, tap on the program icon.

Pocket-HouseMap starts in “medias res”. You should immediately define the room’s name.

You can do this in two ways:

1) overwrite directly “Untitled 1 ”

2) tap the diamond and choose one of the names in the list: for example bedroom.

If you handwrote a new name, you can choose to add it permanently to the list by selecting:
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After the initial hard work, we are ready to have a look at the main window.

The main window will appear on your screen. This is composed of the Plan Worksheet , Status
bar , Toolbox , Control box  and the Pan Diamond .

Let’s have a closer look at these elements.

The Status bar

The Status bar  will appear at the bottom of the screen. This contains the main commands of the
program in pull up menus.

To display menu commands, tap on the desired menu title.

To activate a command, first tap the display of the menu in which it is contained, then tap the
command itself.
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Plan Worksheet Window
The area that fills most of your screen is the working area.

This area has infinite dimensions so it does not limit the user to predefined drawing sizes.

Zoom  and Pan functions are available on the Control Box , if you want to change the working
area on your screen.

The Toolbox
The Toolbox  contains tools that enable you to design rooms with their diagonals
to insert doors and windows, and to give dimensions. These specialized tools are
also useful for completing your design with surface areas, text, Hotspots and
symbols.

When you first open the program, the Toolbox  is situated at the left hand-side of
your screen.

You can move this box in the usual manner by pressing the external part of the
area at the top of the box and dragging it to where it is most convenient.

If you need more screen area,tap on the Tools menu and select the command
Toolbox . In this way, you will close the Toolbox .

To bring back the hidden palette, select Toolbox  from the same menu.

To activate any tool in the Toolbox , tap its icon: the activated tool will be
highlighted.

Attention: To help you understand the function of the various tools and to remember how to
use them, each one will become available only when its use is appropriate. For
instance, if you have not drawn the sketch of a room, the program will not make
any icon available to you except those for drawing a room.

The Control Box

You will find this box at the bottom of your screen. It can be moved to where it is most
convenient and can be removed from the screen by choosing Control Box  from the Tools
menu. To bring it back, select Control Box  again from the Tools Menu.

This window is primarily for control rather than input.

The icons in this box allow you to control the view of a drawing on your screen and  delete the
selected elements (Trash icon).
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Zoom in

The Zoom in  function allows you to enlarge the drawing to see the details better.

Tapping this icon will enlarge the drawing.

Zoom out

This works the same way as the Zoom in function, with the opposite result.

Fit in window

This function makes the edges of the drawing snap to fill the screen.

Trash

This icon allows you to erase the selected elements.

Pan Diamond
To see a different part of the drawing, you can move the “paper” up, down,
right, left and center by tapping one of the four arrows, or by selecting the center
point.

The Help Bar
You can activate/deactivate a help bar from the Tools menu, which will appear at the top of the
window.

It is a step by step guide to help you to carry out the project by indicating the procedures to
follow.

The Room Archive Menu
This pull down menu is at the top right-hand side of your screen.

 

This is used to select the single rooms already stored. The last item “Building", is active only
after you have already connected the rooms.

As we will see, you can open rooms from the archive and place them on the worksheet to make
modifications.
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The list in the room archive will grow automatically when you have finished the measurements of
one room and started the next room by activating the command “New Room ” from the Rooms
menu.

Numeric KeyPad
In some circumstances it is difficult to insert numbers by handwriting them. In this case you can
put a “Numeric Keypad ” from the Tools menu on the screen.

Undo
The Newton System has an integrated Undo function, which is displayed at the
base of the screen. Most kinds of functions in Pocket-HouseMap can be undone
simply by tapping this icon.

Go to Notes
It can be useful to write some notes, descriptions or information regarding the project you are
working on.

By selecting the command "Go to Notes " from the Action menu, you can display the standard
notes function on your Newton, where you can write your personal notes.

Once you have completed the operation, close the notes with the close box and Pocket-
HouseMap will be reactivated with the current drawing.

This works only if “Notes” are not selected in the backdrop.

If they are selected, proceed as follows:

• tap on Extra

• tap on “I” menu

• select Memory Info

• a slip will appear

• choose your backdrop.
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Chapter 2 Some basic operating principles

To save, open and close a document

Saving a new document

When you begin a new document (for example, when you begin drawing a building), the name
of the project will be Untitled-1 and will appear on the title bar of the Worksheet.

This name reminds you that this project has never been saved: if the application should
suddenly be closed, all the data and variations you have made will be lost. In effect, you will lose
the document.

You should save the document you are working on and name it right from the beginning.

To perform this operation:

• choose Save or Save as…  from the File menu

• on the slip that appears, write the name you want to give the document

• confirm the name by tapping on OK.

The name you give the project replaces ‘Untitled’ in the title bar.
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Saving an already saved document

In the upper part, you choose whether to store in the internal memory or on the card.

In the middle part, you have a list of all the Pocket-HouseMap files already stored.

In the bottom part, you can write a new file name.

Saving a copy of the document

If you activate the Save as…  command when the document already has a name, you create a
new variation of the project by saving a copy of the original under a different name. The work
carries on in the document with a new name.

Closing a document

To close a document, simply choose Close  from the File menu.

If you perform this operation but you did not save the last modifications made, the program will
prompt you with a warning slip, giving you the option to save it.

Creating a new document

When launching Pocket-HouseMap, the screen will display an empty untitled drawing sheet, on
which you can begin a new project.

When you are already inside the program and you want to begin a new project, choose New
from the File menu.

Opening an already filed document

If you want to resume work on an already filed project, you must activate the Open  command
from the File menu.

A slip will appear for selecting files: select the document you want to open by tapping its name
and confirm your choice with OK.
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Selecting the elements
Before performing any modifications or operations on the objects you have already put into the
drawing (rooms, text, dimensions, etc.), you must select the objects themselves, by choosing
the best selection from among those described in this section.

Generally, to select the elements, activate the Arrow  tool, found in the Toolbox.

Individual selection

You can select one object by:

• activating the Arrow  tool

• tapping on the Hotspot of the object so that it changes appearance.

If you have to select a room, tap anywhere inside it and it will become highlighted.

If you have only one object selected in the drawing, you can deselect it by tapping any point on
the worksheet.

To select a wall, tap on it and it will be highlighted by a thicker line.

To select an object, tap on its Hotspot and it will be highlighted by a diagonal line.
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Part 2: A guided tour

Chapter 3 Defining the basic settings

You may want to begin by setting the parameters for your work.

Basic settings
Choose Basic Settings  from the Action menu. The following slip will open:

All three settings are pull-down menus.

Unit:

Using the Unit  menu of the Edit/Program Parameters  dialogue, you can select from among the
following measuring systems: metric, imperial with feet and decimals of feet, imperial with feet
and decimals of inches, imperial with feet and fractions of inches.

If you choose the imperial system, whenever you select a numeric input field, Pocket-HouseMap
displays a window simplifying the operations involved in writing numbers.

This window has fields for each unit (feet, whole inches, decimals of inches, fractions of inches).
You can write figures in every field, cancelling or correcting entered values, using the standard
Newton technique. Each operation executed in this window updates in real-time the original field
in which the measurement has to be entered.
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Format:

The options in the Format menu allow you to choose the level of accuracy as shown below:

Note: In the current version there are only decimal divisions.

Communication:

For communication settings you can select from among the following modes:

You can download the work to a desktop PC either directly by serial connection, or through the
Appletalk (Localtalk) network. For a detailed description, please consult the chapter
“Downloading to Pocket I/O”.

A very useful aid in introducing measurements is the Disto Lasemeter from Leica. It is very
simple to use:

• plug in the special serial cable from the Disto to the Newton

• select Leica Disto  in the Communication menu

• select Leica Disto or Leica Disto Memo (depending on the distanziometer
template available) from the Communication menu.

Now every time there is an input field which awaits numerical input, Pocket-HouseMap directly
recognizes the data measured by the Disto.

Important: In the Newton System Version 2.0 it is necessary to deselect the Disto from the
menu before quitting the application.
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Chapter 4 Drawing a room

Having defined the basic settings, you now begin drawing a room.

To draw a room, define its basic shape and provide a minimum number of diagonal
measurements from reference points or corners. This will fix the angles and relationships of the
walls and objects contained in the room.

Drawing the perimeter of the room
There are four tools with which you can sketch the room: 90° polylines, free polylines, 90° boxes
by 2 points, “L” shaped rooms by three points.

90° polylines:

Introducing a list of points will create a sequence of perpendicular lines

The lines are forced to 90° angles.

Sometimes it is desirable to proceed on the same line with the next segment. In this case,
Pocket-HouseMap will understand this and will not force you to turn 90°.

To terminate the input, the last tap must be done on the original starting point.

Important:  Naturally, you cannot cross over the lines.
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Free polyline tool:

In this case the basic shape of the polyline will correspond to the introduced points
without any adjustments.

To terminate the input the last tap must be done on the original starting point.

Important:  Of course you cannot cross over the lines here either.

Box-shaped room:

In “as-built” drawings of modern flats, you can easily assume that the walls are
perpendicular to each other. So in many cases, the basic shape of a room can be
a single box.

To put this form on your plan, just tap the 2 opposite corners.

“L” shaped room:

The L shaped room's also quite frequent. Here you need just 3 taps to define the
shape:
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Assigning wall lengths
To activate the tool for assigning lengths to walls:

• tap the Measurements icon in the Toolbox.

Measurements can be assigned when the program prompts you either by selecting each wall in
sequence or in the order you choose.

Assigning measurements with automatic wall selection.

After activating the Measurements  tool, you will see one of the walls has a black dot at one
end.

It indicates the wall for which a measurement is required and the corner to which a value must
be attributed.

At the bottom the following slip appears .

This input palette distinguishes between the Length (L) and the Height (H) of the wall.

The framed number 5.55 is always the actual value read based on the proportions of the
drawing.

There are three ways to add a different measure:

1) handwrite the value

2)use the Numeric Keypad

3)use electronic measuring equipment such as the Disto from Leica

✍ Let’s look at the first case:

• just write your measures by hand in the free space

• wait until the handwriting is recognized

• if you want to change the proposed height, do the same in the next editing field
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• first cancel the present value

• write by hand and wait for recognition

• Tap OK and the program will move to the next wall.

How to insert a measure in decimal Feet and Inches

Let’s assume you want to write 3’4”,55

• by tapping in the length field, the program will display the following slip:

• write the number 3 in the feet and inches field:

• as soon as the program recognizes the number, the original slip is updated:

• now write the number in whole inches:
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• finally, the tenths of an inch:

For measurements in feet and fractions of inches, write the numerator and denominator on each
side of the fraction symbol and Pocket-HouseMap will automatically simplify the inch fraction,
thus:

Now you can either write in other measurements in the same way as before or close the input
window by tapping anywhere outside the window.

Note: you don’t need to follow any pre-set order (e.g. feet, inches, fractions of an inch) –
when inputting your figures: all the editable fields can be re-edited anytime.

In some conditions, it is easier to use the Numeric Keypad  instead of handwritten recognition.

To activate the Keypad:

• go to the Tool menu

• select the “Numeric Keypad ”

The only difference from the normal working method is that you HAVE to indicate where you
want the numbers to appear.

Hint: The Newton is also sensitive to fingernails, so you do not even need the pen to
tap the numbers.

For electronic input the basic equipment is the Disto from Leica. Future versions of Pocket-
HouseMap may also have other connections. (For requests, you can E-mail
home@cigraph.com, or ask your dealer).

To see how to connect Leica-Disto, see the chapter 3.

Once connected, the input procedure is the same as the one with the Keypad only that, instead
of tapping the numbers you will click the button on Disto and the values will be downloaded
directly to the input field.
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Once the Length has been introduced, you can also change the Height of the corner in the
same way. Given that in most cases corners do not have different wall-end heights, Pocket-
HouseMap requests only one value for each wall.

The corner to which the value belongs is highlighted by a thicker dot.

The main difference between the input interface of the Length and of the Height is that the last
value of the Height is always proposed for the next wall too. In contrast the value of the Length
is the one proposed by the program as read from the drawing on the screen.

When the Length and the Height are correct, tap the OK icon and the program will
automatically select the next wall in a clockwise direction. This procedure will be
repeated until all the walls (and if present all the diagonals) have a value.

It is often not necessary to add new values to a Length if the proposed measurements are
already acceptable. This is the case of a square room. After you have given values to the first
and second wall, just tap OK for the third and fourth wall.

Note: You can reselect a wall and change the values at any time. However remember
that the Measurement icon has to be selected, otherwise you cannot insert values.

Hint: When you have to change a value, first cancel the old value (it’s faster in many
cases). Most people are not able to correct existing numbers on the Newton “on
the spur of the moment”.

Defining Diagonals

The procedure is extremely easy when the corners are all of 90°. But Pocket-HouseMap will
also make your life enjoyable with rooms without right-angles.

You can define the diagonals of the room thereby creating a triangulation with which its
configuration can be fixed.

Basically, you need to define the minimum number of diagonals for the fixing of the room, but
you may also provide as many diagonal measurements as desired, without the program taking
into consideration those which are redundant.

Diagonal measurements may be given from corner to corner.

To draw diagonals, tap the Diagonal icon in the Toolbox.

Then:

• tap on the first corner from which a diagonal will be drawn

• then tap on the final corner of the diagonal
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The image below shows a diagonal which has been defined:

 

Continue this process until all necessary diagonals have been defined.

To remove a defined diagonal:

• activate the Diagonal tool

• tap the diagonal to be eliminated: it will be marked with a dot

• tap the Trash icon.

Once you have drawn the diagonals, you can give them their respective measurements by
tapping the Measurement  tool.

The program will automatically select the first diagonal you drew and display it, with a dot:

    

• Write the values in the (L) length input field

• Wait for recognition

• If this measurement is acceptable, tap OK.

You can continue assigning measurements to the diagonals sequentially as the program makes
the selection, or you can select any desired diagonal at random with the pen.



Pocket-HouseMap 20

Measuring diagonals with Leica Disto and reference bar

A reference bar can be unfolded in Leica Disto in order to determine diagonals, in this case you
can use the relating option in Pocket HouseMap to add 50 mm (0.16 feet) to the result to
compensate the contribution of the bar.

Fixed Room

Pocket-HouseMap will use the term “Fixed Room” when there are no more doubts about
measurements and the whole geometry is defined.

You can tell if the room is already fixed by the corners. In the earlier stage every corner is
indicated by a small circle; once the room is fixed those circles are converted into boxes.

There are 2 ways to fix the room:

a)By introducing all necessary diagonals (usually n-3, where n indicates the number of walls).
After all the measurements of the walls and diagonals have been introduced and there are no
more doubts, the room will automatically be considered as “fixed”.

b) Often there are rooms which you know have corners of 90°. In these cases there is no need
for diagonals.

Once you have introduced all the wall lengths (in the case of a box there are only 2 sides
needed) you can obtain the fixing of the room in the following way:

• select Fix Room…  from the 

• the program asks you to reconfirm:

To “unfix” a room without diagonals, just change one of the wall-lengths.

Note: You cannot insert doors, windows or objects without having fixed the room first.
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Hint: If possible, avoid inserting only a limited number of diagonals (less than n-3). The
outcome can be unpredictable.

Rotating a room
Before you pass to your next work, it is often better to vary the position of the drawing in the
worksheet by rotating it.

Proceed this way:

• activate the Arrow  tool and select a wall

 

• choose Rotate  from the menu Action and a slip will open giving you two
alternatives:

• the option X axis will rotate the room so that the selected wall will become
horizontal

• the By Angle option will rotate the room by the angle you specify when you
move the horizontal bar.

Deleting a room
To delete a room do the following:

• activate the Arrow  tool and select the room by tapping inside the room

• tap the Trash icon.
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Chapter 5 Defining doors and windows

In this chapter, we will see how to place doors and windows in your design and to control their
characteristics.

Before you can place a door or window in the wall of a room, you need to give it dimensions.

When placing doors, their names and locations will be important because they can be used to
join rooms together.

This procedure will be described in detail in chapter 8.

Placing a door
To put a door in a wall of your room, activate the Door tool in the Toolbox.

Then:

• tap on the wall that is to receive the door

• tap the corner from which you will set its distance in the wall

A Door Settings  slip will open:

You have to write down an unique name in the door input field! Let’s say you are doing the
bathroom, and its door opens towards the bedroom. So we will call it the door bath/bed.

When you introduce the measurements of the adjoining bedroom you will find yourself with the
same door but opening from the other room.
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At this point, in the next room you can simply tap the diamond menu at “Doors”, and all the
doors of the current flat will be listed.

Choose bath/bed:bathroom. At this point all the parameters previously given to this door will be
reproposed again.

                  

The sizes of the door, height and width, should not create any problem of interpretation.

The distance from a reference vertex is the measured value between the vertex and the corner
of the door.

The 4th value indicates the size of the wall in which the door is inserted.

Note: When all rooms are being joined, there will be no more request for the wall
thickness. This is the only place in the program in where you can define these
sizes.

Door types:

Pocket-HouseMap has 4 door types and different opening options:

1) doorway

2) single door

3) double door

4) door with flanking

Once you have written all values and selected all options, tap OK.

You will see the door appear in the wall:
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Modifying inserted doors

When you need to change some characteristics of a door that has been entered or to remove a
door from the room:

• activate the Door  tool

• tap over the edge of the door to be modified

• the Door Settings  slip will appear.

You can change any of the parameters that appear in the slip and confirm the new settings by
tapping OK.

If you want to remove the door from the room:

• select the Arrow  tool

• tap on the door to remove it

• wait until the door is selected

• tap on the Trash  icon.

Placing windows

The procedure for placing a window in a wall is the same as that for placing doors, except you
use the Window  tool and its options in the Window Settings slip.

Just as in the case of the doors, the windows can only be placed after the room has been fixed.

Once you have activated the Window  tool:

• tap on the wall in which the window is to be placed

• tap at the corner from which you will set its distance in the wall

The Window Settings  slip will open:

You can give the window a convenient name for identifying it in room calculations in the
Window  field.

Values are already proposed for most general informations: sizes of the window (height and
width), distance from the floor and thickness of the wall.

In the empty input field, you are prompted to write the distance from the vertex in the same way
as you did with the doors.
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You can choose between four different window types:

- window frame

- fixed pane window

- window with rebate

- window with splayed jambs

You confirm the window settings by tapping OK and the window will be placed in the wall with
the symbol shown below:

Attention: If you entered widths or distances that do not allow a window to actually be placed
in the wall of a room, an acoustic warning will inform you of the specific problem.

If you try to place windows in such a way that will cause them to intersect in the
elevation view with other windows or doors, a warning slip will appear informing
you that this is not possible.

Modifying inserted windows

When you need to change some characteristics of a window that has been entered or to remove
a window from the room:

• activate the Window  tool

• tap over the edge of the window to be modified

• the Window Settings  slip will appear.

You can change any of the parameters that appears in the slip and confirm the new settings by
tapping OK.

If you wish to remove the window from the room:

• select tha Arrow  tool

• tap on the window to be removed

• wait until the window is selected

• tap on the Trash icon.
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Chapter 6 Completing the drawing of a room

Pocket-HouseMap provides tools for completing the drawing of a room with Hotspots, text,
dimensions and objects.

Inserting Hotspots
While doing the drawing of a room, you may need to fix some points that can be used either for
general reference or as known points.

Pocket-HouseMap provides a tool specifically designed for this purpose. These Hotspots can be
placed anywhere in your drawing or located by specific measurements.

Although Hotspots appear on your screen, they are used for reference only and cannot be
printed or plotted.

To insert a Hotspot, use the Hotspot tool  found in the ToolBox. There are three
ways to insert Hotspots.

Inserting Hotspots with the ‘Free’ position option

To place Hotspots in this way, select Free position.

After tapping OK in the slip, you can now place Hotspots anywhere by tapping on your screen.
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Positioning Hotspots by distance

You may wish to position Hotspots in a wall at a specific distance from a corner.

In Pocket-HouseMap, you can locate Hotspots in this manner once you have assigned a
measurement to a wall.

Then:

• tap on the Hotspot icon

• a slip opens, from which you can select Distance :

• the slip changes, requesting the distance.

• write the distance from the corner and tap OK

• point at the wall

• point at the corner

The Hotspot will be located in the wall.
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Positioning Hotspots by "Radius"

You can locate a Hotspot by the intersection of two circles in reference to the corners of the
room or to other Hotspots.

The program will consider the first two points you tap on the screen as the centers from which
the circles will be constructed for determining their intersections.

The procedure is as follows:

• tap the Hotspot icon in the Toolbox to bring up its slip and select Radius

• Write the radius for each of the 2 circles and tap OK

• Point out the 1st. reference vertex

• Point out the 2nd. reference vertex
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• Point at the chosen intersection

Removing a Hotspot

To remove a Hotspot , select it with the Arrow tool and tap the Trash icon.

Dimensioning
Pocket-HouseMap allows you to change the dimensions between any set of points in the
worksheet.

Placing a dimension

 Tap on the Dimension  icon from the Toolbox:

In the Dimension area you choose from a list of options:

Horizontal : this option will give you horizontally projected dimensions between
the points tapped on the worksheet.

Vertical : this option will give you vertically projected dimensions between the
points tapped on the worksheet.

Parallel : this option will give you dimensions parallel to the points tapped in the
worksheet.
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You can also choose between the various ways of having your dimension lines appear in the
drawing:

- only with markers

- markers with predetermined short witness-lines

- markers with uniform length witness lines

- markers with witness lines that have a uniform clearance between the points tapped and the
end of the witness line.

If you are dimensioning a series of successive points, you can choose between Linear
Dimensions (the length of each segment in the series) and Base-Line Dimensions (the
progressive length at each point).

You have two ways to define the dimension: with or without automatic point detection

Point detection on

To make your work easier, you can get the program to automatically collect all important points
along the wall. For this operation all you have to do is activate the Automatic point detection :

• tap the wall you want to dimension

• all the important points will be highlighted by small circles

• tap the place where you want the dimension line to be seen.
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Detection off

Let’s now look at the case of “deactivated” point detection:

• tap all the single vertexes, points, objects requiring dimensioning

• to end, tap the last point twice

• point where you prefer to have the dimension line.

Cancelling dimension lines

To remove a dimension line:

• select the Arrow  tool

• tap the dimension line

• once highlighted, tap the Trash icon .

Text
This tool is used for placing text in your drawing.

During this procedure, Cigraph made a slight exception to the usual Newton interface approach.
There was the risk that text might appear after the handwriting recognition process in
undesirable places, where it might be difficult to reselect and move amongst furniture.

The following steps are necessary for introducing text

• select the Text icon from the Toolbox

• with the pen, point at the place where you want to introduce the text

• an input slip will appear

In the upper part, you can write the text that you would like to introduce into the drawing. The
input field follows all the usual Newton rules for handwriting.

In the lower part you can select the font type, size and style.
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Cancelling text

To move or erase the text:

• select the Arrow  tool

• point at the text till it becomes covered by a gray field

• move the text around with the pen or, to erase, tap the Trash  icon.

Changing text

To change the text parameters:

• tap the Text  icon

• tap the beginning of the text

• the text slip will appear

• make your changes.

Note : In the beginning you will sometimes select the whole room instead of just the text.
Over time, you will see that it is not difficult to accurately select the text alone.

Library objects
Libraries can be used to quickly place objects in the room you are drawing by furnishing it with
fixtures, appliances and the like.

Objects can be positioned in the room in the same way of the Hotspots: free, or by distance.

Once you have tapped the Symbol  icon, the following slip will open.
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The 2D symbol that you see has a little square indicating the relative origin for its insertion in
the drawing . Depending on how you want to position the object, you can relocate the origin by
selecting another significant point of the symbol.

The Arrow-buttons  just below the view window allow you to advance through the library one
object at a time.

In the width and depth field you can redimension the object.

With the Rotation field you can specify a rotation in degrees around the origin
highlighted with a box in the symbol.

The angle will be referenced from the X axis when placing objects with the Free
option or referenced to the wall you select when placing with the Distance
options.

To better understand how it works, refer to the next section.

Placing an object in the drawing

Using the Free hold position

After tapping OK, you can place objects anywhere in the worksheet with a tap.

When the object is placed, it will be rotated by the angle specified in the slip.

Remember that these objects are placed without being referenced to any known point in the
drawing beside the insertion points.

Positioning objects by Distance from vertex

You may want to position objects in a wall at a specific distance from a corner.

On the right side of the screen you find the input field, where you can write the
value of the distance.

Proceed as follows:

• write down the distance

• tap OK

• tap the reference wall

• tap the reference corner.
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The object will be placed in the drawing and rotated directly in reference to the selected wall.

In the following example you can see 2 bath tubs, both where placed with Zero rotation.

The difference is that the bath tub in the middle of the room has been placed using
“Free”method , whereas the second one has been placed using “Distance” option. In this last
case the upper wall has been selected as reference wall.

Modifying an object in your drawing

You can modify objects that are placed in your drawing by selecting them, tapping the Library
tool and changing the parameters for the symbol.

You can remove any selected object by tapping the Trash  icon.
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Chapter 7 Archiving rooms

In the worksheet, you can draw and modify one room at a time: when you have completed a
room, you can archive it to make the worksheet available for drawing the next room.

You can archive a room that has only been sketched and access it later for modifications and
completion.

The archiving is automatically done when you select “New Room ” from the Rooms menu.

All the archived rooms are collected in the upper Room Archive menu.  By tapping on the
Room archive , the list of all archived rooms will appear.

The last item “Building ” puts the joined rooms on the screen. We will describe this later in the
section on joining rooms.

To put a single, already existing room on the screen, simply select the name of the room, and it
will appear ready for additional work.

Should you need to change a room name, select the room from the Room archive  and tap the
command "Name Room… " from the Rooms menu on the bottom of the screen.

The same slip will appear when you start with a new room.

Now you can change the present name in the editing field.
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Chapter 8 Completing the building

Joining rooms together
Once you have completed each room and archived them, you can assemble the whole flat. As
you already gave all important values to the rooms, once you select the command Join Rooms
from the Rooms menu, the program will connect all the rooms together as a unique group.

The whole arrangement is done by automatically finding all the rooms with common door
names. The wall thicknesses are taken from the door input slips.

You can still select and change the values of the single rooms. Once you repeat the request to
display the flat, the program will ask you if you want to update the building with new elements:

Important note:  It is the user's responsibility to check that all doors have the correct
     name in common with their own neighbouring rooms.
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The final drawing and the outer perimeter
Once you have completed all the data you want to enter, you can move on to the automatic
outer perimeter creation.

Proceed as follows:

• tap Make Perimeter  from the Rooms menu

• the following slip with a pull-down menu will appear

The program will automatically draw a perimeter around the building at this uniform distance. If
during this procedure the program meets a wall with an opening, it will consider the thickness
you entered before inputting the Settings for the placed door/window.

To change the perimeter you have to recalculate it with new values.

Note: You can hide and show the outer perimeter by selecting the command Show
Perimeter from the Rooms Menu.
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Chapter 9 Quantity calculations

For each archived room, Pocket-HouseMap can calculate wall surfaces, floor area, doors and
windows, perimeter length and room volume.

When the project is completed, the program also calculates the outer perimeter length and totals
both the wall footprint areas and floor areas in the building.

You can read most of these results only after the data has been downloaded to a desktop PC
with the application Pocket I/O. This limitation was necessary due to the memory and speed
limitation of today's Newtons. In future versions of the Newton, it will be probably integrated
directly in Pocket-HouseMap.

What you can see today is the calculations of the surface and perimeter length.

Only the surface calculation, the perimeter length and the room volume can be displayed at
present.

Tap Info Room  from the Room menu:

In the Rooms menu, you will find the command About Design . Use this command to display the
slip that lists the total perimeter, the surfaces of the rooms and the walls, the total surface area
and the overall volume.

You can read all additional calculations only within Pocket I/O.
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Chapter 10 Print

You can print both the individual rooms and the whole design, depending on what you are
displaying on the screen.

The Print  command in the File  menu displays a dialog that allows you to fine-tune the print
scale percentage: by leaving it at 100%, the print scale is optimized to the chosen page format.

By confirming the settings with OK, the standard Newton print dialog box will appear, which
allows you to:

• choose the sheet orientation

• select the printer

• display the print preview

When ready, just click on Print .
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Chapter 11 Downloading to Pocket I/O

To win the challenge of porting HouseMap to the Newton device, we had to find a compromise.
Since we would have to overload the Newton's memory with a heavy application, or split the
program functions into the two following applications:

- on the Newton, the procedures needed for outdoor work

- on the Desktop, the procedures needed for I/O, printing etc.

We chose the second approach and developed Pocket I/O for data-exchange. With Pocket I/O
you can print the drawings or calculations, export to DXF or GDL dataformats for other CAD
programs, and add your own Symbol library to the Newton.

Since HouseMap has a very specific data structure we could not rely on the general applications
usually used for data-exchange between Newton and Desktop.

Installing Pocket I/O

Macintosh version

To install Pocket-I/O, insert the disk into your Desktop and double click on Pocket-I/O Installer .

The folder that contains the program is installed in the chosen folder. The two extensions, which
are part of the program, are automatically installed.

Windows version

Copy the files from the floppy disk to your hard disk:

Pocket-I/O,

cdil_dll.dll

fdil_dll.dll

Connection
You can connect the Newton directly by serial cable, or integrate it on an AppleTalk network.

• tap Connection  from the Action menu

• select which connection type you prefer (Serial, AppleTalk)

• the Newton is now ready for connection
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• go to the desktop, start Pocket I/O and select “Import from Newton ” from the
menu File; the following dialog will appear:

On the Macintosh computers

Select the connection type (Tools ) and the Serial Port .

On the Windows computers

Select the Serial Port
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On both platforms

With Connection Status you can see whether there is currently an active connection with the
Newton.

Note: The cable connection is NOT enough! You always also have to have a software
connection activated.

• Select the folder where you would like to save files coming in from the Newton

• Click Connect  on the Desktop

• Tap Connect on the Newton

Note: You have to give the command both on the Desktop and on the Newton!!!

When the connection is successful, you will see the message “CDIL is connected ” in the
Connection Status.

When this doesn’t happen, in most cases one of the following problems occurred:

- cable wrongly connected
- cable connected to the wrong port
- wrong port selected in the menu
- on the Macintosh: extensions disabled.

Downloading drawings from the Newton
After connection is activated:

• Tap on the Newton the command Export…  from the menu File.

After a few seconds, the following message will appear on the desktop:

At this point, the File has been saved into the selected folder.
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If you have used symbols in your drawing, Pocket I/O will also create folders that contain the
symbol files in GDL and DXF format.

The name of the folders will be made by the program adding GDL or DXF to the file name.

E.G.: File name "Casa" that contains symbols in GDL and DXF format. The folders will be:
CasaGDL , CasaDXF.

Note: You can download only those projects that are open at that moment on the
Newton.

Before starting to download the file, connect must unify all the rooms.

Downloading Symbols to the Newton
In some cases it could be necessary to add personal symbols to the library. The simplest way to
do this is to import a file in DXF format, or to create a text file describing the geometry of the
symbol.

Hower, archives saved in DXF format do have limitations: only the two-dimensional part of the
document and only the primitive graphics - such as line, arc and circle - will be read.

Open the connection as described above and, instead of running the command “Export” from
Newton, this time select the option you want from the “Send symbol” section on the PC:

• If you want to import just one text file that describes the symbols geometry, click
the button Pocket-HouseMap ;

• If you want instead to read a DXF-format document, click the button DXF.

A dialog box will ask you to choose the file that represents the symbol.

After confirming with OK, the desktop will send the symbol to the Newton.
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Creating / Deleting Symbol-textfiles
To create a symbol for Pocket-HouseMap’s library, open a text editor and introduce the relevant
values of the coordinates of the object that you propose to insert.

Use the following syntax:

SYMDEL: name of the symbol to be cancelled
SYMSET: name of the symbol, Hsx, Hsy, width, height
SYMLIN:  Ax,Ay, Bx,By
SYMARC: Cx,Cy,Ax,Ay,Bx,By
SYMEND

where

HSx,HSy  are the coordinates of the symbol’s preferential Hotspot
WIDTH : dimensions of rectangle that contains the symbol
HEIGHT: height of rectangle that contains the symbol
Ax,Ay : end points of a line or initial point of an arc
Bx,By: end points of a line or final point of an arc
Cx,Cy: center of an arc

If a symbol with the same name already exists in the library of the symbols, the last one will be
substituted with the new one.

Examples 1

cancel a symbol “ chair 1”:
SYMDEL   “chair 1”

Example 2

create a new symbol called “cube”
SYMSET:  cube,0,0,300,300
SYMLIN: 0,0,300,0
SYMLIN: 300,0,300,0
SYMLIN: 300,300,0,300
SYMLIN: 0,300,0,0
SYMARC: 150,150,150,300,150,300
SYMEND

Note: Having edited the coordinates, each line of information must be concluded by
typing Return .
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Chapter 12 Using Pocket I/O

Once you have finished the downloading, you must open the saved file.

The drawing will appear with all symbols and dimensions.

Let's first look at the calculations that were missing on the Newton.
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Rooms Calculations

You can display the calculated data for the rooms by choosing Show Calculations… of Rooms
from the Windows menu.

You can see an archived room’s data by choosing its name in the pop-up menu the middle of
the room card.

The following information appears in each archived room’s card:

Perimeter and Area of the room, plus the Volume  of the room, which is calculated from the
floor area and using the average wall height (Hm= H1+ H2 + ….+ Hn / n).

Name, 1.Height,  2.Height, Length,  Total Wall Area (calculated with door and window surfaces
included) and Net Wall Area (which is calculated without the doors and windows) of each Wall
of the room.

Name, Width , Height , Areas  and Openings of the Doors of the room.

Name, Width , Height , Sill Height  and Areas of the Windows .

As we will see later, these data can be printed or exported for further manipulations in other
programs.
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Building calculation
You can display the calculated data for the building by choosing Show Calculations… of
Building  from the Windows menu.

Perimeter Length  calculates the outer perimeter of the building.

Total Floor Area calculates the combined total of the interior room floor areas.

Total Wall Footprint Area  sums the total footprint of the walls including thresholds of the doors.

Total Floor Area sums the Total Floor Areas of the rooms and the Total Wall Footprint Area.

Attention: If you have not provided the perimeter for the building, only the Total Floor Area
for the rooms will be calculated.

Display
Pocket-I/O is not a CAD program, so the editing capabilities are very limited. But for a better
control over the drawings, we have included some display functions.
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Chapter 13 Pocket I/O: Printing and Exporting

Once you have completed your work, Pocket-I/O gives you the option of printing the documents
or exporting them electronically for use in other programs.

Printing drawings and calculations
With Pocket-I/O, you can print the drawings of the rooms complete with text, dimensions, etc. or
you can print a list of calculated information about the rooms, giving their floor areas, sizes,
doors and windows, etc.

Page setup

Whatever the information you choose to print, you may first want to set the basic printing options
choosing Page Setup from the File menu.

Printing a drawing

You can print the drawing currently displayed in your worksheet by choosing Print…  from the
File menu.

The Print Settings  dialog box will open as shown below.
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In the Number of Sheets  box you will be informed of the sheet layout necessary to print the
drawing centered in the sheets.

The number of sheets and the layout is determined by the Format  set in the Page Setup , the
Orientation  of the drawing and the Print Scale  you set in the upper right of the Print Settings
dialog. The Fit in Sheet Scale  indicates the largest possible scale at which the image can be
printed on one sheet of paper.

With the Text Size  options you can instruct the program to print text as set in the respective
tools by choosing Fixed , or it can be printed with reference to how the graphic image is being
rescaled for output by choosing Scaled with Drawing .

In the Options  box you can choose to print the diagonal measurement lines and/or the
dimension lines and/or an outline in your drawing.

In the Pen Size  field you can specify the thicknesses at which walls and the external perimeter
line, diagonals, dimensions and outlines will be drawn. Doors, windows, diagonals and
dimensions will always be drawn at the minimum pen size (0.1 mm)

When you confirm your printing setup with OK, you will be presented with your typical Print
Options  dialog box:

If you want to print all the calculations of the rooms, choose Print Calculations… of Rooms
from the File menu.

The typical dialog box will open where you can set printing options; when you confirm the
choices, the calculations will be printed with the information organized in a spreadsheet-type
layout of columns and rows.

It is possible to print only a list of doors in the building by choosing Print Calculations.. of
Doors  from the File menu.

When printing a door schedule, you will have the additional information showing the rooms to
which the doors are connected.
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Exporting a document
You can save your Pocket-HouseMap files in different formats for exporting to other programs by
choosing Export… from the File menu.

HouseMap 1.3

The features of the desktop version of HouseMap make it the ideal postprocessor of surveyed
data for many uses. In this case you should save your document in HouseMap format.

GDL 4.1 format

As noted, GDL is a macro based language that allows ArchiCAD to compose 3D objects.

You can save your HouseMap file as an object in GDL format and it will be composed of a 2D
symbol associated with the 3D description in the binary GDL format. The binary GDL format
allows ArchiCAD to generate 3D models extremely quickly.

The 2D plan view image of the GDL object that your file has saved will be completed with text
and objects; Hotspots will automatically be added at wall line intersections and edges of doors
and windows.

Dimension lines will not be saved in the file.

The examples below show a HouseMap file that has been saved in the GDL format and opened
inside ArchiCAD:
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The 3D model constructed by the GDL description will appear as wall planes with openings
where doors and windows are located.

Doors that have been combined between rooms will appear in the model, with their head and
jambs connecting the wall planes.

If you add a perimeter line to the building, windows will appear in a similar fashion.

To export your building as an object in GDL format, choose Export… GDL  from the File menu.

The program will propose a name for the file by adding .GDL to the name of the project file. You
can change the name by selecting any part of it and typing your preference.

DXF 2D

The commonly used file format DXF is frequently not interpreted correctly by some programs,
when all the 3D data are included.

To make the work easier, we offer the possibilities to filter out all the 3D data which are not
necessary for a clean 2D representation of the drawings.

DXF 2D ArchiCAD

This format is aimed at ArchiCAD’s users. With this option Pocket-HouseMap produces entire
lines without interrupting them with doors and/or windows.

When you export your file to ArchiCAD, the program will automatically recognize the perimeter
of the rooms and will change them into walls with the space-click procedure.
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DXF 3D

The DXF format is used by many CAD programs to exchange files. To export a HouseMap file in
DXF format, choose Export… DXF from the File menu.

The program will propose a name for the file by adding .DXF to the name of the project file. You
can change the name by selecting any part of it and typing your preference.

As in GDL, the DXF files are exporting walls as planes. However, since DXF does not allow the
description of surfaces, the walls will be described by a method of triangulation.

The HouseMap files are saved in DXF version 10.

Exporting in PICT format

HouseMap allows you to save a copy of the room or the completed building in your worksheet in
PICT format for use in other programs.

Choose Export… PICT  from the File menu and a dialog box will open, in which you can name
the file with the .PICT extension proposed.

Exporting in BMP format

For the Windows platform, you can save a copy of your file in BMP format.

Choose Export… BMP  from the File menu and a dialog box will open in which you can name
the file with the .BMP extension proposed.
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Exporting in Text format

When you export in text format, you will create a text file of the quantity calculations.

Choose Export… Text from the File menu. A dialog box will open and the program will propose
a name for the file by adding .Text  to the name of the project file. You can change the name by
selecting any part of it and typing your preference.

HouseMap uses the standard Tab delimited file format so that the files it generates can be
imported to spreadsheets, databases and word-processing programs.

An example of a spreadsheet is shown below:
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